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If you have switched on your computer and you are currently at the Windows

desktop, then you are ready to start with your first lesson.

There are two ways to operate the Excel functions, either by using the Mouse or using the

Keyboard.   We suggest that you use the mouse for this training session, however for an

understanding of the keyboard method, take note of the keyboard instructions as they will enhance

your keyboard performance.  All keyboard instructions are detailed with each step-by-step guide.

All step-by-step guides are highlighted in italic text.

* Follow all the steps to each lesson, they are clearly highlighted.

LESSON 1.

Welcome to Microsoft Excel.  Excel is a powerful electronic spreadsheeting program designed with

many advanced features that make working with numerical figures much easier and faster.  Excel

stores entries electronically thus enabling easy editing and updating.   Excel automatically calculates

formulas and it is designed to automatically recalculate a formula if entries in the referred cells have

been changed.  The automatic calculating feature is one of Excel’s strongest functions' as it will

ensure that our results are always 100% correct, which is important when dealing with facts and

figures.  All companies deal with financial calculations of some sort, most companies control these

calculations by applying them to spreadsheets of various kinds.

Step 1.    From the Windows desktop, run the Microsoft Excel program.

RUNNING THE EXCEL PROGRAM

a.   Double-click on the Microsoft Excel icon if it is available on your

       desktop

or

a.   Click on the Start button located at the bottom left of the screen

b.   Move your mouse pointer up to the Programs option

c.   Move your mouse pointer over to the Microsoft Excel option and

      click once with your left clicker

*    You will be presented with the Microsoft Excel window

At the top of the window is the 'Name' bar it displays the program name and the sheet name on the

left and on the right of this bar are the 'Window Size' icons.
Minimize  Maximize  Close
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If your window is not 'maximised' you will need to complete step 3.

Step 3.    Maximise the 'Microsoft Excel' window size so that it will take up the entire space of the

                screen.

MAXIMISING A WINDOW

a.  Click on the Maximise icon located on the right of the Name bar

A spreadsheet design is made up of grids, with columns running across the screen and rows running

down the screen.  At the top and left of the sheet you have labels. Each cell is referenced by a

column label and row label. (Example: B6, AB700, X45)  There are 65,536 rows and 255 columns

available in each spreadsheet.

The cursor specifies which cell you are currently

in, it  is displayed by a highlighted border.

The Main Menu bar contains all the functions of the Microsoft Excel program.  Each menu name

activates a pull-down menu containing a group of functions.

Step 4.     Activate the 'Edit' menu and view the functions on the pull-down menu.

ACTIVATING A MENU

a.  Click on the E in Edit (Notice the E is underlined)

Step 5.    Press the 'Right Arrow' key to move to the 'View' menu, study the functions available

    on the 'View' menu. (The Right Arrow key is located in the middle of the keyboard)

Step 6.    Press the 'Right Arrow' key again to move to the 'Insert' menu, study the functions

                available on the 'Insert' menu.

Notice that on some menus an 'Extra Menu ' option appears at the end of the menu.  If you point to

this option with your mouse pointer you will be presented with additional functions on the current

menu.
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Step 7.     Position your mouse pointer to the 'Extra Menu' option.  Notice the 'Name' and 'Picture'

                 options now appear on the menu, they have a small symbol on the right side which

                 indicates that there is another menu attached to this option.  Move the mouse pointer to

                 the 'Name' option a menu will appear, view the menu. (Do not click)

Step 8.     Move the mouse pointer down to the 'Picture' option and view its menu. (Do not click)

Step 9.     Press the 'Escape key' to cancel this menu, (The Escape key is top left of your keyboard)

                 press the 'Escape key' again to cancel the pull-down menu, press the 'Escape key' again to

                 cancel the selection of the 'Insert' menu. (Notice it is highlighted slightly)

As well as having functions organised on the 'Main Menu' bar, you also have two toolbars called the

Standard and Formatting toolbars, they contain graphical icons designed to run the most commonly

used functions. These two toolbars may be displayed as one toolbar on your screen, if this is the

case you will need to move the Formatting toolbar under the Standard toolbar otherwise you will

spend too much time scrolling to find your icons.

MOVING A TOOLBAR    (Only move the Formatting toolbar down under the Standard toolbar if

                                              you have only one toolbar on your screen)

a.  Point your mouse pointer on the vertical line located at the beginning of the toolbar, your

      pointer will switch to two double-headed crossed arrows being the move symbol

b.  Click-drag the toolbar down slightly into position

c.  Release clicker

The Standard toolbar contains icons for many of the popular standard functions such as Save,

Open, Print, Copy and Spellchecker.  Icons are designed to make activating a function easy, as all

you need to do is click on the icon. The graphics make the icon and function easily identifiable.

Step 10.     Activate the 'Zoom' function and select 75% so we can view more cells on our sheet.

ZOOM

a.  Click on the Zoom scroll bar located right of the Standard toolbar

*   A menu will appear

b.  Click on the 75% from the menu provided

Scroll bar

Beginning of Formatting

Toolbar

Beginning of Standard

Toolbar
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The Formatting toolbar contains format functions such as Bold, Underline, Colour, Left align,

Centre align, Right align, Borders, Size, etc. These are commonly used formatting functions

therefore they have been dedicated an icon.

Both toolbars can be customised so you may have some different icons on your toolbars than on

the diagram above.

The Reference bar specifies which cell you

are currently positioned in and it displays what

is in the cell. In this diagram you are in cell B7

and in the cell is a formula that sums up the

data that is in cells B3 to B5.

The Sheet and Scroll bars are at the bottom of the screen.  The 'Scroll icons' allow you to scroll

left and right of the current sheet, the 'Sheet tags' allow you to go to another sheet within the

workbook. Each workbook has several spreadsheets within it, just like several pages to the one

book.  You can add more sheets to the workbook.

Step 11.     Switch to 'Sheet2' and scroll to the right until you see column X.

SWITCHING SHEETS SCROLLING RIGHT

a.  Click on the Sheet 2 tag a.  Click on the Right scroll bar

Step 12.     Switch back to 'Sheet1'.  (Click on the Sheet1 tag)

There can be more toolbars displayed on the screen, the number of toolbars depends upon which

toolbars are called to the screen.  We will explore other toolbars later.

We will study moving around the cells of the spreadsheet.

Step 13.      Currently you are in sheet 1, cell A1, press the Right Arrow   key several times or

                   hold the Right Arrow key down until you reach the column labelled 'BC'.  The label is

                   displayed at the top of the column. There are 255 columns across the screen the last one

                   is labelled IV.  Read the cell reference displayed left of the 'Reference bar' it should

                   now be 'BC1'.

The active cell is highlighted with a border
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 Level 1In many cases we will be using 'Shortcuts' to move around within our sheet, these Shortcuts are

performed via the keyboard.  This method of activating commonly used functions is quick and easy

as you will not need to remove your hands from the keyboard to the mouse and you have more

control. On your keyboard you have additional keys such as the Alt key, the Ctrl key, the Home key,

the End key and arrow keys, take note of where they are positioned.

Step 14.    Go to the first cell of the sheet, being cell A1, use the Shortcut for doing so.

GO TO THE  BEGINNING OF A SPREADSHEET  (A1)

a.  Hold down the Ctrl key   (The Ctrl key is located at the bottom of your keyboard)

b.  Press the Home key once  (The Home key is located amongst the special keys)

c.  Release both keys (Notice your cursor is now in cell A1)

Step 15.    Press the 'Down Arrow'    key until you reach row 10. The row label is displayed at

                  the beginning of each row. Press the 'Page Down' key until you reach the row labelled

                  1000, the 'Page Down' key will take you down one full screen at a time. There are 65536

                  rows available to each sheet.

Step 16.    Return to the top of the spreadsheet (A1) again using the Shortcut for doing so. (Hold

                  down the Ctrl key, press the Home key once)

Step 17.    Go to 'Sheet2'. (Click on Sheet2 tag)

Step 18.    Go to cell C2000 using the 'Go To' function for doing so. It will take to long to use the

                  arrow keys.

In this case we will use the menu method of activating a function so we can identify where the 'Go

To' function is located within the menu system.

GO TO

a.  Click on Edit from the main menu

b.  Click on Go To from the next menu

c.  Enter C2000 into the reference area (Click in area and type)

d.  Click on the OK button

Step 19.    Move to the beginning of the current row (cell A2000)

                  using the Shortcut for doing so.

MOVE TO BEGINNING OF ROW

a.  Press the Home key once

Ctrl+Home key

Home key
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   Move to the beginning of the spreadsheet again. (Press Ctrl+Home)

Step 21.    Go to 'Sheet1'.  (Click on the Sheet 1 tag)

Step 22.    Go to cell 'CU2100' using the reference toolbar.

REFERENCE TOOLBAR

a.  Click on the Reference scroll bar located top left of the screen

b.  Enter the cell reference CU2100

c.  Press Enter key to finalise

*   Notice that you are currently in cell CU2100

Step 23.    Move to the beginning of the spreadsheet again. (Press Ctrl+Home)

As you can see there are many cells within a sheet and there are many sheets within a workbook. As

we have not entered anything into the sheet it remains empty.  We will not be prompted to save the

sheet as it is empty, however, if you have by mistake entered a character or number you will need to

answer 'No' if the 'Save' message appears.

Step 24.    Exit the 'Microsoft Excel' program.

EXITING THE PROGRAM

a.  Click on File from the main menu

b.  Click on Exit from the next menu  *  You will return to the Windows desktop

LESSON 2.

Step 1.    Have your computer switched On and run the Microsoft Excel program. (Double-click on

                the Microsoft Excel icon or click on the Start button, move to Programs option, move to

                Microsoft Excel option and click on it)

Step 2.    Type the column titles with the 'Caps Lock' key on as shown below to cells A1, B1 and C1.

ENTERING TEXT INTO CELLS AND MOVING ACROSS

a.  Type the text

b.  Press the Right Arrow  key to move your cursor to the next cell on the right and to finalise

      your entry and close the cell  (If your cell is not closed the icons on the toolbars become inactive)

A B C

1 BILL AMOUNT PAID
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*  Text is automatically aligned to the left of a cell, each cell has a default width of nine (9) character

    spaces.  Column titles are generally positioned at the top of each column.

*  Text is not embedded into the cell until you have moved the cursor out of the cell which closes

    the cell.  If the cursor is inside the cell, it is opened, if a cell is opened you can not perform a

    function, so you must close the cell by either pressing an Arrow key or by pressing the Enter key.

Step 2.    Enter the following row titles into cells A3, A4, A5 and A6.

ENTERING TEXT INTO CELLS DOWN ROWS

a. Type the text

b. Press the down  arrow key or press the Enter key

    (the cursor will move down on Enter)

*  Row titles are generally located at the beginning

    of each row.

Step 3.    Enter the following numbers into cells B3 to B6 as shown below.

* Numerical entries are aligned to the right of the

   cells lining up the units, tens, hundreds and

   thousands.

Step 4.    Enter the following dates into cells C3 to C6 as shown below.

*  Dates are also aligned to the right as they are

    actually numerical entries.  Often calculations

    are performed on date entries.   For example.

    Today’s date plus seven days gives us a result.

    Today’s date minus yesterdays date gives us a

    result. (We will be working with dates later)

*  Numeric entries can have a variety of formats.  For example: Percentage (15%), Currency with

    two decimal places  ($15.00), Normal (15), etc.

When you wish to edit/change the format of more than one cell you must select the cells first

so the Microsoft Excel program knows which cells you are referring to.
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   Select the cells B3, B4, B5 & B6 as they contain numbers. (cells B3 to B6)

SELECTING CELLS

a.  Position your cursor on the first cell (B3) by clicking on it

b.  Hold down the Shift key which is the select key  (Keep holding the

     Shift key down)

c.  Press the Down Arrow key until you reach cell B6

*   Your cells should be highlighted in black specifying these cells are

      selected, the first cell in white  indicates the location of  your

     cursor

d.  Release all keys

Selecting is performed with a combination of the Shift key plus the Arrow keys or you can also

click-drag the mouse pointer over the cells to select them, however be careful not to end up moving

the cells instead of selecting the cells when using the click-drag method.  Remember this as you

will be regularly performing this function.

Step 6.   Using the Increase icon, increase the decimal display to 2 decimal places for the numbers

               currently selected.

INCREASING DECIMAL POSITION

a.  Click on the Increase Decimal icon located on your Format toolbar

*  The decimal position can be increased or decreased by simply clicking on the appropriate icon.

Step 7.    Cancel the selection that is currently on.

CANCEL A SELECTION

a.  Press the Down or Up Arrow key              or Click anywhere on the sheet

*   The highlight is removed

Step 8.     Select the cells B3, B4, B5 & B6 again. (Position your cursor on the first cell (B3) by

    clicking on it, hold down the Shift key, press the Arrow key until you reach cell B6,

    release all keys)

Step 9.      Increase the decimal display to '3 decimal places' for the numbers currently selected.

                 (Click on the Increase Decimal icon once)

Step 10.    Cancel the selection. (Press the Down Arrow key)

Often we may regret applying a function, lucky for us we have an 'Undo' function the will undo

what we have just done.
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   Use the 'Undo' function to undo the increase of the decimal position to three.

UNDO

a.  Click on the Undo icon located on the Standard toolbar

The 'Undo' function will undo the last function performed, it differs from the 'Escape key' as it

cancels a menu selection. If you have gone through and performed a function that you did not really

want to do, remember the 'Undo' function.

Currently all your work is stored in a temporary memory called 'Random Access Memory' (RAM).

If the power source is turned off you will lose your work.  We must save the sheet if we want to

store it permanently.

If you are in a classroom situation ask your teacher which folder you should be saving your

files to.  We have created a folder on the C drive and called it 'Excel Lessons', we will be using this

folder to save our files to, if you do not have a specified folder then you can save your files into the

'My Documents' folder.

Step 12.    Save this spreadsheet into your folder and call the spreadsheet ‘Lesson1’.

Saving a file is one of the most important functions, as it may have taken you some time to create

your spreadsheet in the first place and you do not want to lose it.

SAVING A FILE

a.  Click on File from the main menu  

b.  Click on Save from the next menu 

c.  Click on the Save In scroll bar and select the disk drive of where your folder is located

*   A list of folders and files belonging to the drive you have currently selected is displayed

d.  Double-click on your folder from the list provided  (ensure that the folder name is displayed in

     the Save in area to confirm your folder selection was successful)

e.  Click at the beginning of the Filename

     area the default name will be highlighted

f.   Press the Delete key to delete the default

      name

g.  Type Lesson1 as the new filename

h.  Click on the Save button to finalise

You can use the

scroll bar and view

the last functions

performed
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Once a file has been saved the name will appear at the top of the screen on the 'Name' bar.

All spreadsheets are given the extension XLS.

A filename cannot contain the following characters.   .   /   \  |   ?  (   )  { } [ ] or  *

Step 13.     The spreadsheet is now complete so we can close it as we no longer need it.  It is best

                   to close a sheet after you have finished with it, otherwise it will use up memory which

                   can slow down the processing unit.

CLOSING A FILE

a. Click on File from the main menu

b. Click on Close from the next menu

Currently you have no spreadsheet loaded in your working area.  Try to type or enter some

characters and you will soon discover that nothing happens.

Continue to the next lesson.

LESSON 3.

Step 1.     Use the 'New' function to call a new spreadsheet to the screen.

NEW

a.  Click on File from the main menu or Click on the New sheet icon

b.  Click on New from the next menu

*   The New window will appear and the Workbook icon

     is selected

c.  Click on the Ok button located at the bottom of the

     window

*   A new sheet is presented within the Excel window area

Step 2.    Enter only the column titles to cells B1 to E1 as

                shown below. (Type text, press Right Arrow key)

A B C D E

1 JUNE JULY AUGUST TOTAL
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   Return to cell A1 using the Shortcut for doing so. (Press Ctrl+Home)

Step 4.    At this stage save your spreadsheet into your folder, call it ‘Lesson2’.

a.  Click on File from the main menu  

b.  Click on Save from the next menu  or click on the Save icon

c.  Click on the Save In scroll bar and select the disk drive where your folder is located

d.  Double-click on your Folder (ensure that your folder name is displayed in the Save in area)

*   Notice that your previous file is listed

 e.  Click at the beginning of the Filename area the

      default name will be highlighted

 f.   Press the Delete key to delete the default name

g.   Type Lesson2 as the new filename

h.   Click on the Save button to finalise

*   Notice the filename is now displayed on the 'Name

     bar' at the top of the screen.

Step 5.    Enter the row titles to cells A2 to A7. (Type text, press Enter key the cursor moves down)

A B C D E

1 JUNE JULY AUGUST TOTAL

2 MARY

3 TED

4 WILBA

5 SIMON

6

7 TOTAL

*  Notice the cell reference above the sheet displays your cell reference and the cell content.

Step 6.  Move to cell A2 using the 'Cell Reference' area to do so.

CELL REFERENCE AREA

a.  Click on the Cell reference scroll bar located on the right side of the cell reference area

b.  Enter the cell reference A2

c.  Press the Enter key to finalise the entry

*   Notice you are now in cell A2
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   Edit the current entry using the 'Edit' function to do so. Change the text 'MARY' to

                'MARY-JO'. The Edit function will open the cell and prompt the cursor inside the cell at

                the end of the data so we can delete, add or change what is in the cell.

EDITING DATA WITHIN A CELL

a.  Press the F2 key which positions the cursor at the end of the text within the cell

b.  Type -JO

c.  Press Enter key to finalise the entry and close the cell

Step 8.    Move to cell A3 (Press Arrow keys), change the text from 'TED' to 'TAMMY'.

EDITING AND DELETING DATA

a.  Press the F2 key to edit the data in the cell

b.  Press the Backspace key twice to delete the last two characters

c.  Type AMMY

d.  Press the Enter key to finalise and close the cell

Step 9.     Enter the following numbers to the body of your spreadsheet as shown below.

A B C D E

1 JUNE JULY AUGUST TOTAL

2 MARY-JO 56.89 23.56 104.50

3 TAMMY 89.65 125.70 90.65

4 WILBA 76.45 32.67 87.98

5 SIMON 34.67 113.67 56.89

6

7 TOTAL

Step 10.     Select the column titles in cells B1 to E1.  (Click in cell B1 hold down the Shift key

  which is the selecting key, press the Right Arrow key three times, the cells should be

                   highlighted in black except for the first cell as that is where your cursor is currently

                   placed)

Step 11.     Use the 'Center Align' function to place the column titles in the center of the cell.

There are 3 main cell alignments: Left, Centre and Right.  They are located on the Formatting

toolbar.  The alignment function works within the individual cell.

CENTRE ALIGN

a.  Click on the Centre icon located on the Formatting toolbar  Left          Center         Right
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   Cancel the selection. (Press the Down Arrow key or click anywhere on the screen)

Step 13.    Move to cell E2 (Press Arrow keys), calculate the total for cell E2 using the 'Sum'

                  formula.

The most famous feature of Excel is its ability to enter formulas to cells which calculates with cell

references not actual numbers.  All formulas entered into a cell must begin with the '=' symbol to

specify that it is a formula. In the formula detailed below it will sum the total of whatever is in the

cells from B2 to D2 and place the answer in cell E2.

SUM FORMULA

a.  Position your cursor in cell E2 (Click on it)       -  this indicates the answer is to go here

b.  Type =SUM(             -  this is the sum formula

c.   Move to cell D2 with your left arrow key            - this is the beginning of the range of cells

d.  Hold the Shift key down and move to cell B2     -  this selects the cells B2 to D2

*   Notice a dashed border appear around the cells indicating these cells are selected.

e.  Release the Shift key           -  as we have finished selecting

f.   Type   )           - this specifies the end of the range you

            want to sum (Close bracket)

g.  Press the Enter key          -  to finalise the formula

*   The result of the formula is now displayed

Step 14.    Move to cell E3 and enter a formula that will sum what is in cells B3 to D3.  This time

                  use the click-drag method for selecting the cells that are to be summed.

a.  Position your cursor in cell E3 (Click in it)         - this indicates the answer is to go here

b.  Type =SUM(               - this is the sum formula

c.  Click-drag the mouse from cell B3 to D3             - this selects the cells to sum

d.  Type )             - finalise formula (Close bracket)

e.  Press the Enter key - finalise the entry

Step 15.    Move to cell E4 and  enter a formula that will sum what is in cells B4 to D4.  (Repeat

                  the above steps)

* As the 'Sum' formula is the most commonly used formula it has been dedicated an icon.

Step 16.    Move to cell E5 and enter a formula that will calculate the 'Total', use the 'Autosum'

                 icon for doing so.

The 'Autosum' function has a default setting that informs what cells are to be selected, it is not

always correct.  It generally sums numerical entries either horizontally or vertically, you must check

that it is selecting the correct cells that you wish to sum. If it does not select the correct cells click-

drag your mouse pointer over the correct cells to tell it that these are the cells you wish to sum.

*  Instructions on next page

=SUM(B2:D2)
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a.  Position cursor in cell for answer E5 (Click in cell)

b.  Click on the Autosum icon located on the Formatting toolbar

c.  Check if the cells it is selecting are correct

*   If they are not correct, select the correct cells by click-dragging over the correct cells (B5 to D5)

d.  Press the Enter key to finalise

Step 17.     Calculate all the Totals for cells B7, C7, D7 and E7 using the 'Autosum' function.

Step 18.     Select cells A7 to E7.  (Click on cell A7, hold down the Shift key, press Right Arrow key

      until you reach E7, release all keys)

Step 19.     Apply the 'Bold' function to the select cells.

BOLD

a.  Click on the Bold icon  or press Ctrl+B (Shortcut)

Step 20.    Whilst the cells are still selected apply the 'Underline' function.

UNDERLINE

a.  Click on the Underline icon  or press Ctrl+U (Shortcut)

Step 21.    Cancel the selection.  (Press Down Arrow key)

Step 22.    Select the column titles (cells B1 to E1) and apply the 'Bold' function. (Repeat above steps)

Step 23.    Cancel the selection. (Press Down Arrow key)

Step 24.    Perform the 'Save' function to re-save all the new workings  that you have added to the

     sheet called 'Lesson2', the save will update the relating file on the disk.

Remember what you have entered since the last save has not been updated to the disk, it is only

entered onto the screen and held in the temporary memory (RAM). You will need to activate the

'Save' function to permanently store it onto the disk.  When you perform the 'Save' function and the

sheet already has a name it automatically updates the file stored on the disk, you will not be

prompted to give the sheet a name as it already has one.  This process is done very quickly, you may

not notice it is done.

RESAVE

a.  Click on File from the main menu              or click on the Save icon

b.  Click on Save from the next menu

*   The resave is done very quickly you can view the progress at the bottom of the sheet
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   Change the entry in cell A5 to read ‘FRANK’.

EDITING THE ENTIRE TEXT IN A CELL

a.  Click on cell

b.  Type new text

*   The existing text will be overwritten

As there is generally little text in a cell, it is often easiest to overwrite the text, rather then to edit the

cell, delete the text, re-enter the new text and close the cell.

Step 26.     Edit the text ‘Frank’ and make it read ‘Fred’ use the 'Edit' function for doing so.

                   (Position the cursor on the cell, press the F2 key, press the Backspace key to delete the

                   last three characters, type the new text, press the Enter key to finalise the editing and to

                   close the cell)

Step 27.     Go to the top of the sheet being cell A1.  (Press Ctrl+Home)

Being confident in using shortcuts for getting around, editing and deleting techniques can increase

your speed when it comes to editing major sheets.  Today speed is a major desired skill in the

business place.

Step 28.     Perform the 'Save' function again to resave the sheet and update the related file on the

                  disk with the new entries. (Click on Save icon)

Step 29.     The sheet is now complete and it has recently been saved, so we can close it.  (Click on

   File from the main menu, click on Close from the next menu)

Step 30.     View the last files you have created.

VIEWING LAST FILES CREATED

a. Click on File from the main menu

b. Look at the end of the next menu and notice the last files displayed

Step 31.    Cancel the File menu

CANCELING A MENU

a.  Press the Escape key once to cancel the pull-down menu

b.  Press the Escape key again to cancel the File menu selection
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    Use the 'New' icon to call a new sheet to the screen.  (Click on New icon)

Step 33.     Set up the following sheet as shown below. Enter the Row titles, the Column titles and

                  the numbers to the body area.  Do not enter the amounts that are shaded as they are the

                  result of the 'Sum' formula.

Step 34.     Select the row titles (cells A2 to A7)  (Click-drag over cells A2 to A7) , apply the 'Bold'

                   function. (Click on the Bold icon)

Step 35.     Select the column titles (cells B1 to E1) (Click-drag over cells), apply the 'Bold' and

                   'Center' align functions. (Click on Bold icon, click on Center icon, press Down arrow

                   key to unselect)

Step 36.    Use the 'Sum' formula to calculate the totals for column E and Row 7.  (Position cursor

                  in the cell which is to receive the result, enter the sum formula =sum(, select the cells to

      sum by click-dragging over them,  enter a close bracket ) to specify the end, press the

      Enter key to finalise the formula)

Step 37.    Select all the cells that contain a formula and apply the 'Bold' function. (Click on cell,

                  click on Bold icon) or (Click-drag over a group of cells, click on Bold icon)

Step 38.    Save the sheet and call it 'Practice-1'. (Click on File, Click on Save, Ensure your Folder

      is displayed in the Save In area, enter the filename Practice-1 into the Filename area,

      click on the Save button)  Notice the filename on the Name bar, then close the sheet.

      (Click on File, click on Close)

Step 39.    Exit the program.

EXIT

a. Click on File from the main menu

b. Click on Exit from the next menu

Your folder

should be

displayed here

Notice all your

files are listed
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LESSON 4.

Step 1.    Have your computer switched On and run the Microsoft Excel program.  (Click on the

               Microsoft Excel icon, Start button, Programs option, Microsoft Excel option)

Step 2.    Enter the following spreadsheet title into cell A1 “THE BLIND ASSOCIATION”.

Step 3.    Use the 'Merge and Center' function to create a spreadsheet title and to center the title

                between A1 and E1. This function is not the same as the 'Centre Align' function as it

                centres the text across multiple cells.

MERGE AND CENTRE

a.  Select cells A1 to E1 (Click-drag over cells A1 to E1)

b.  Click on the Merge and Centre icon located center on the Formatting toolbar

c.  Press Down Arrow key to cancel the selection

Step 4.    Enter the column titles to cells B3 to E3 as shown below. Apply the 'Bold' and 'Centre'

                function to the column titles. (Select cells B3 to E3, click on Centre icon, click on Bold icon)

A B C D E

1 THE BLIND ASSOCIATION

2

3 JAN FEB MARCH TOTAL

4

5 WILBA JONES 58 98 76

6 MARY PARKER 45 67 87

7 SALLY EVANS 23 43 45

8 JOHN NEWMAN 76 54 32

9

10 TOTAL

Step 5.    Enter the row titles to cells 5A to 10A, notice that the text does not fit within the

    column width. After entering the text widen column A so the text fits the cell width.

COLUMN WIDTH

a.  Position the mouse pointer on the right side of the column label  (between labels A and B)

*   Notice the mouse pointer changes to two crossed double headed arrows which is the move

     symbol (You will be moving the column border to the right)

b.  Click-drag to right until the text fits the cell then let go of the clicker
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     Select the row titles in cells A5 to A10 , apply the 'Center' function.

Step 7.      Move to cell A1 using the Shortcut  (Press Ctrl+Home), apply the 'Bold' function to the

     the spreadsheet title.  (Click on Bold icon)  Notice that the text is actually in cell A1 even

     thought it appears between cells A1 to E1.

Step 8.      Now enter the numbers into the body area of the sheet which is between cells B5 to D8.

Step 9.      Apply the 'Sum' formula and calculate the totals for column E. (Position cursor in cell,

                  =sum(, select cells by moving to the first cell, hold down the Shift  key and move to the

                  last cell using the arrow keys, type ),  press Enter key to finalise)

Step 10.     Apply the 'Sum' formula and calculate the totals for row 10. (Repeat steps from above)

                   (See results on page 22)

Step 11.     Change the entry in cell B5 to 65 and notice the formula results change.  (Click in cell,

                   enter 65, press Enter key)

Step 12.     Change the entry in cell B5 back to 58 using the 'Undo' function for doing so. (Click on

                   the Undo icon) Notice the formula results have automatically recalculated.

Step 13.     Save the spreadsheet calling it ‘BA’. (Click on

                   File, click on Save, ensure that your folder is

                   selected, enter filename, click on Save button)

Notice that all your files (Spreadsheets) are listed in your

folder.

Step 14.     Close the sheet as we are finished with it.  (Click

                   on File, click on Close)

There are two main kinds of formulas. The formula where you wish to sum a group of cells often

referred to as a range of cells and the formula is called a 'multiple cell formula'.  where you wish to

add, subtract, divide or multiply one cell with another which is called a 'single cell formula'.

Take note of the key strokes for the following, they are located on your numeric keypad which is on

the right side of your keyboard:

ADD + MINUS   -

MULTIPLY * DIVIDE   /
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REVISION QUESTIONS

Which two keys would you press to move the cursor to cell A1?

____________________________________________________________________________

Which key would you press to move the cursor to the beginning of the row?

____________________________________________________________________________

Which key is used in conjunction with the Arrow keys to select cells?

____________________________________________________________________________

What function do the following icons perform?

 ___________________________________________________

 ___________________________________________________

____________________________________________________

____________________________________________________

What is the difference between the 'Centre' function and the 'Merge and Centre' function?

____________________________________________________________________________

____________________________________________________________________________
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Which key performs the 'Edit; function?

____________________________________________________________________________

Prior to activating the 'Centre' function what must you do if you want to centre multiple cells?

____________________________________________________________________________

What character specifies that a formula is entered into the cell?

____________________________________________________________________________

What formula would you enter if you needed to sum all the entries between cells C1 to C15?

____________________________________________________________________________

In a formula what do the four symbols stand for?

/    __________________________________    *   ___________________________________

-    __________________________________    +   ___________________________________

What two keys do you press to activate the 'Go To' function?

____________________________________________________________________________

How can you tell if a file has been saved?

____________________________________________________________________________

Why is it important to close a cell once you have entered text into it?

____________________________________________________________________________

____________________________________________________________________________

Under which main menu are the last files created listed?

____________________________________________________________________________
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LESSON 5.

Step 1.     Have your computer switched On and run the Microsoft Excel program.  Open the file

                 called ‘BA’.

OPEN A FILE

a.  Click on File from the main menu or Click on the Open icon

b.  Click on Open from the next menu

c.   Select the folder where the file is located it must be displayed in the Look In area

d.  Click on the filename BA from the listing supplied

e.  Click on the Open button

Step 2.    Add the row title and entries to row 11 as shown below.  Add the row title to cell A12.

                (Do not enter numerical entries for row 12 as they are to be calculated using a formula)

Note:  All cells that are shaded contain a formula that returns the result do not enter these numbers

           in manually.  We entered them so you can check your results.

A B C D E

1 THE BLIND ASSOCIATION

2

3 JAN FEB MARCH TOTAL

4

5 WILBA JONES 58 98 76 232

6 MARY PARKER 45 67 87 199

7 SALLY EVANS 23 43 45 111

8 JOHN NEWMAN 76 54 32 162

9

10 TOTAL 202 262 240 704

11 UNIT PRICE 12.3 14.5 15.5

12 TOTAL PRICE 2484.6 3799 3720 10003.6

Step 3.    Calculate the ‘Total Price’ for cell B12 by multiplying the 'Total' in cell B10 by the

                'Unit Price' in cell B11.

MULTIPLYING ONE CELL WITH ANOTHER

a.  Position your cursor in cell B12 (Click in it) -to specify where you want the answer

b.  Press = -to indicate a formula is entered

c.   Select cell B10  (Click on the cell)

d.  Press * - to multiply

e.  Select cell B11 (Click on the cell)

f.  Press the Enter key -to finalise formula

Step 4.     Calculate the 'Total Price' for cells C12 and D12.  (Repeat the above steps)

=B10*B11
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   Calculate the 'Total' for cell E12 by summing B12 to D12. Use the 'Sum' formula.

    (Position cursor in E12, =sum(, select cells D12 to B12, ), press Enter key)

Step 6.     Re-save the file to save all new changes.  (Click on File, Click on Save)

If your file was not resaved after editing and you attempt to close it, Microsoft Excel will warn you

and ask if you wish to save the file before closing it.

Step 7.     Close the file as we have finished with it.  (Click on File, click on Close)

At this stage you can exit out of the program and finalise your training or continue to the next

lesson.

LESSON 6.

Step 1.     Have your computer switched On and run the Microsoft Excel program.  Open the sheet

                 ‘BA’ again.  (Click on File, click on Open, click on BA, click on Open button)  Enter the

                 column titles as shown below replacing the existing text. (Click, Type)

Step 2.     Select cells B5 to D8. (Click in  cell B5, hold down the Shift key, press Right Arrow key

                 to column D and Down Arrow key to row 8)

Step 3.     Delete the selected entries and notice the formulas recalculate, then cancel the selection

DELETING DATA

a.  Press the Delete key

b.  Press the Down arrow key to cancel the select function

Step 4.    Enter the new entries to cells B3 to D8 as shown below. Notice the formulas recalculate.

A B C D E

1 THE BLIND ASSOCIATION

2

3 APRIL MAY JUNE TOTAL

4

5 WILBA JONES 103 289 612 1004

6 MARY PARKER 425 540 376 1341

7 SALLY EVANS 487 269 644 1400

8 JOHN NEWMAN 209 412 403 1024

9

10 TOTAL 1224 1510 2035 4769

11 UNIT PRICE 12.3 14.5 15.5

12 TOTAL PRICE 15055.2 21895 31542.5 68492.7
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We have edited the spreadsheet called ‘BA’.  What you have changed on your screen has not been

saved to the relating file on your disk so the original file remains unchanged on the disk. You now

have two choices; you can re-save this file and it will update the original file on the disk, or you can

close the file and not save the changes so the original file stays unchanged.

Step 5.    Close the file without saving it as we do not want to update the original with these changes.

CLOSING A FILE WITHOUT SAVING ANY UPDATES

a.  Click on File from the main menu

b.  Click on Close from the next menu

*   A message will appear

c.  Click on the No button as we do not with to save the changes

Step 6.    Open the sheet ‘BA’ this time use the file listing on the 'File' menu.  (Click on File, click on

               ‘BA.xls'  located at the end of the menu)

Step 7.     Notice the information on your sheet is as it was prior to the previous editing. Close the

                file. (Click on File, click on Close)

Continue to the next lesson from this point.

LESSON 7.

Step 1.     Call a new sheet (Click on New icon), enter the text ‘MACDONALD’S FARM’ to cell

                 A1, select cells A1 to E1 and apply the 'Merge and Center' function.  (Have cells

                 selected, click on Merge and Centre icon)

Step 2.     Enter the following text as shown below.  Widen column A (Click-drag the column

                 border out), apply the 'Bold' and 'Centre' functions to the column titles. (A4 to D4)

A B C D E

1 MACDONALD’S FARM

2

3

4 ANIMALS QTY PRICE TOTAL

5

6 KANGAROOS

7 RABBITS

8 HORSES

9 EMUS

10

11 TOTAL



LCN: QLD1206  - OUTBACK EDUCATION SERVICE
©

Page 25

MICROSOFT EXCEL 2000

LEARNING STAGE 1  Level 2

    Move to cell A1 (Press Ctrl+Home key), increase the size of the spreadsheet title to 18.

SIZE

a.  Position cursor in cell A1 as the text is actually in this cell

b.  Click on the Size scroll icon located on the Formatting toolbar

c.  Click on 18 (You may need to scroll down to the 18)

*   Notice the text is larger

Step 4.     Enter the following numbers into the body of your spreadsheet

                as shown below.

A B C D E

1 MACDONALD’S FARM
2

3

4 ANIMALS QTY PRICE TOTAL

5

6 KANGAROOS 54 155.6

7 RABBITS 67 17.8

8 HORSES 83 350

9 EMUS 29 650

10

11 TOTAL

12

Step 5.     Select cells C6 to D11 (Click on cell C6, hold down the Shift key and press the Down

                Arrow key until your reach D11), add the 'Currency' format to the selected cells.

CURRENCY

a.  Click on the Currency icon located on the Formatting toolbar

*  Notice that the decimal position automatically converted to 2.

Each cell has a default width of nine character spaces, should an entry be larger than nine characters

(or larger than the cell width) a hash symbols ##### will appear.  The program is informing you that

the column is not wide enough and it will needing widening. If this happens to you widen the

column width. (Position cursor between column labels the cursor changes, then click-drag out)

Scroll Up

Scroll Down
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    Whilst the cells D6 to D11 are still selected, decrease the decimal position to 1.

                (Example:  $15.0)

DECREASE DECIMAL POSITION

a.  Click on the Decrease Decimal icon

Step 7.    Calculate the 'Total' for cell D6.  Multiply the 'Qty' (B6) by the 'Price' (C6). Use the

                following formula shown below. (Increase the column width should a cell indicate that it

                is not wide enough)

MULTIPLYING ONCE CELL WITH ANOTHER

a.  Position the cursor in D6                - to specify where you want the answer to appear

b.  Press the =      - to indicate that this cell contains a formula

c.  Move to the Qty being cell B6    - to select first cell

d.  Press *    - to specify that you wish to multiply

e.  Move to the Price being cell C6      - to select second cell

f.  Press the Enter key    - to finalise the formula

When you need to 'move to a cell' you can use either the 'Arrow key 'or you can 'click in the cell'.

Notice the formula reference on the formula bar reads =B6*C6, we are calculating cells not

numbers. If an entry is changed in either of the cells Excel will automatically recalculate the

formula.  This ensures that the answer to the formula is always correct.

Step 8.      Change the entry in cell B6 to read 75, when you press the Enter key notice the 'Total'

                 result change.

Step 9.      Calculate the 'Totals' for the rest of the animals in column D by multiplying their 'Qty'

                 with the 'Price'. (Repeat above steps)

Now you should be getting good at using 'single cell formulas' and the 'Sum' formula.

Step 10.    Calculate the 'Totals' for row 11 using the 'Sum' formula.(Click in the cell that needs the

                  result, type =sum(, select cells, type ), press Enter  key )

Step 11.    Apply the 'Bold' function to all the cells that contain a formula. (Select cells by

      click-dragging over them, click on Bold icon)

Step 12.    Apply the 'Underline' function to all cells in row 11. (Select cells, click on Underline icon)

Step 13.    Close the spreadsheet without saving it.  (Click on File, click on Close, click on No when

                 the Save message appears)  All that hard work gone!

=B6*C6
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LESSON 8.

Step 1.     Create the following spreadsheet on your own.

*  Adjust column widths where necessary

*  Merge and centre the spreadsheet title and set the size to 20

*  Centre column titles

*  Add a Currency symbols to the numerical entries for the ‘Price’ and ‘Totals’.

*  All shaded cells are calculated with a formula do not manually enter the amounts. For the

    ‘Totals’ in column D, use a single cell formula  (B*C) (remember to press the  =  first to indicate

     that this  is a formula cell reference)

*  Calculate the ‘Totals’ for row 11 using the 'Sum' formula. ( =sum(  Select cells, ), Enter key)

A B C D E

1 MACDONALD’S FARM
2

3

4 ANIMALS QTY PRICE TOTAL

5

6 ELEPHANTS 64 $1990.00 $127360

7 DONKEYS 68 $90.00 $6120

8 CAMELS 40 $150.00 $6000

9 DOGS 94 $35.00 $3290

10

11 TOTAL 266 $2265.00 $142770.00

12

Generally you never print a page unless you have Print Previewed it first.  The Print Preview

function will display how the sheet would look printed on a piece of paper.  You will also discover

that margins and often headers and footers are included on a page.

Step 2.     Print preview the spreadsheet so you can see what it will look like printed.

PRINT PREVIEW

a.  Click on the Print Preview icon located on the Standard toolbar

or

a.  Click on File from the main menu

b.  Click on Print Preview from the next menu

*   The Print Preview window will appear displaying your sheet
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    Use the 'Zoom' function to view the spreadsheet in more detail.

ZOOM

a.  Click on the Zoom button located at the top of the screen

Step 4.     Use the 'Zoom' function  to view the whole sheet. (Click on the Zoom icon again)

Step 5.    Display the margins on the sheet.

MARGINS

a.  Click on the Margins icon located a the top of the screen

Step 6.    Close the 'Print Preview' window.

CLOSE A PRINT PREVIEW

a.  Click on the Close button located at  top/right of the window 

Step 7.     Save the file into your folder and call it

                ‘FARM’, then close the file.  (File, Save,

       select your folder, enter the filename Farm,

                 Save button)  (File, Close)

Step 8.    Activate the 'File' menu and activate the extra menu to see if your file 'Farm' is displayed

               at the end of the menu, then cancel the menu. (Press Escape key)

Step 9.    Exit out of the Microsoft Excel program. (Click on File, Click on Exit)
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LESSON 9.

Step 1.    Set up the following spreadsheet. (Where cells are shaded they are calculated with a

    formula, do not enter any numbers manually into these cells)

*  Adjust the column widths where necessary

*  Apply the bold, underline and centre functions where necessary

*  Select cells B4 to F11 and increase the decimal position to 2 for all numerical entries

*  Sum the totals for column F using the 'Autosum' function

A B C D E F

1 January April July October Total

2

3 Quarterly Expenses

4 Gas 144.50 135.60 155.60 178.90 614.60

5 Electricity 121.58 155.69 79.47 114.78 471.52

6 Telephone 258.76 312.49 279.90 189.75 1040.90

7 Rent 1200.00 1200.00 1200.00 1200.00 4800.00

8

9 Yearly Expenses

10 Car Insurance 350.00 350.00

11 Personal Insurance 440.00 440.00

Step 2.    Decrease the decimal position of all numerical entries by one.

a.  Select cells from B4 to F11

b.  Click on the Decrease Decimal icon

Step 3.    Undo the last function which was to decrease by one decimal position. (Click on the

   Undo icon) Notice the decimal position increases by one.

Step 4.    Undo the last function which was to Undo the last function. (Click on the Undo icon)

                Notice the decimal position decreases by one.

Step 5.    Save the file and store it in your folder, call the file ‘EXPO2002’.  (Click on File, click on

                Save, select folder, enter filename EXP02002, click on Save button)  Close the sheet.

At this stage you can finalise your training or continue to the next lesson.
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LESSON 10.

Step 1.     On a new sheet set up the following spreadsheet shown below, adjust column widths and

                centre align column titles.

Step 2.     After entering all the text, select the entire sheet being all the cells of the sheet.

SELECTING AN ENTIRE SHEET

a.  Click in the top left corner of the sheet and all cells will

     become highlighted

Step 3.     Set the size to 9 for all cells of this sheet.

* If the size you need is not available on the size menu, you can manually enter the desired size.

SIZE

a.  Click at the beginning of the current number in the Size icon area

b.  Press Delete key to delete the current number

c.  Enter the number 9

Step 4.     Format the numerical entries for columns C, D, E and F so the have a 'Currency' format.

    (Select cells C5 to F12, click on Currency icon)

A B C D E F

1

2 NAMES UNITS PRICE GROSS TAX 27% NET

3 PER UNIT

4

5 WENDY 54 $15.89

6 MICHELLE 77 $13.46

7 DAVID 89 $13.00

8 PETER 102 $34.80

9 MICHAEL 37 $27.68

10 WAYNE 46 $15.80

11

12 TOTAL

13
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    At this stage save the file into your folder and call it 'Unit1'. Often it is wise to perform

                 the 'Save' function prior to trying something new out. Simply to avoid losing the work

                 already completed.

Step 6.     Add a thick line to the bottom of row 3, (to all cells A3 to F3). Use the menu method for

                doing so.

ADDING LINES

a.  Select cells from A3 to F3

b.  Click on Format from the main menu

c.  Click on Cells from the next menu

d.  Click on the Border tag

e.  Click on the Thick line display in the

     Style area

f.   Click on the Bottom Border in the

     Border area or click on the Bottom

     border icon

g.  Click on the Ok button

The Format window is very popular as it contains functions such as borders, number formats, cell

alignments, fonts, patterns and other format functions that can be applied to data and cells.

Step 7.     Add the same thick line to the bottom of row 12, cells A12 to F12 using the 'Repeat'

                function to do so.

REPEAT LAST FUNCTION

a.  Select cells from A12 to F12

b.  Click on the Edit from the main menu or Press Ctrl+Y

c.  Click on Repeat from the next menu

The difference between the 'Redo' and the 'Repeat' functions are : the 'Redo' function will only redo

something that has been undone, that is if the Undo function has been applied.  The 'Repeat'

function will repeat the last function performed.
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    Calculate the 'Gross' for each person in column D.  The formula will work on the 'Units

                multiplied by the Price Per Unit'.  In this exercise 'Gross' represents 'Gross Wage'.

*  View the diagram on the next page for the results

MULTIPLY FORMULA

a.   Move to cell D5 (Click in it)

b.   Press = - to activate the single formula

c.    Move to B5 (Click in it)

d.   Press * - to specify  multiplication

e.    Move to C5 (Click in it)

f.    Press the Enter key

Step 9.     Calculate the 'Tax' for each person in column E.  The formula will work on the

                'Gross*27%'.  Yes! you can enter fixed numbers to a formula.

PERCENTAGE FORMULA

a.  Move to cell E5 (Click on it)

b.  Press =

c.  Move to D5 (Click on it)

d.  Type  *27%  - to multiply with 27 percent

e.  Press the Enter key

Step 10.     Calculate the 'Net' for each person in column F.  The formula will work on the 'Gross

                  minus the Tax'.

MINUS FORMULA

a.  Move to cell F5 (Click in it)

b.  Press =

c.  Move to cell D5 (Click in it)

d.  Press -

e.  Move to cell E5  (Click in it)

f.  Press the Enter key

Step 11.     Calculate the 'Total' for row 12 using the 'Autosum' function.  (Click in the cell that is to

                   contain the result, click on Autosum icon, ensure the correct cells are selected, press

                  Enter key)

=D5*27%

=D5-E5

=B5*C5
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A B C D E F

1

2 NAMES UNITS PRICE GROSS TAX 27% NET

3 PER UNIT

4

5 WENDY 54 $15.89 $858.06 $231.68 $626.38

6 MICHELLE 77 $13.46 $1,036.42 $279.83 $756.59

7 DAVID 89 $13.00 $1,157.00 $312.39 $844.61

8 PETER 102 $34.80 $3,549.60 $958.39 $2,591.21

9 MICHAEL 37 $27.68 $1,024.16 $276.52 $747.64

10 WAYNE 46 $15.80 $726.80 $196.24 $530.56

11

12 TOTAL 405 $120.63 $8,352.04 $2,255.05 $6,096.99

Step 12.     Print Preview the sheet.  (Click on Print Preview icon)

Step 13.     Zoom-in on the Print Preview. (Click on Zoom button)

Step 14.     Zoom-out on the Print Preview.  (Click on Zoom button)

Step 15.     Cancel the Print Preview screen.  (Click on Close button)

Step 16.     Resave the sheet and close it.

At this stage you can exit the program or continue to the next lesson.

LESSON 11.

We need another spreadsheet with the same layout as the previous sheet 'UNIT1'.  To avoid having to

recreate the spreadsheet we will open ‘UNIT1’ and save it to another name which will make it an

entirely new sheet as it will be named differently.  We edit the new sheet as needed and resave it.

When you save a spreadsheet to another name it performs the same function as copying the entire file.

Step 1.     Switch On your computer and run the Microsoft Excel program. Open the file called

'UNIT1'. (Click on File, click on Open, click on Unit1, click on Open button)
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    Apply the 'Save As' function and save this sheet to another name.  Call the new sheet

                 'Unit2'.

SAVE FILE AS ANOTHER FILE

a.  Click on File from the main menu

b.  Click on Save As from the next menu

c.  Enter the new filename ‘UNIT2’ to the Filename area

d.  Click on the Save button

*   Notice the new filename on the Name bar at the top left of the window

Step 3.     Change the 'Units' amounts as shown below (column B), notice all the formulas recalculate.

A B C D E F

1

2 NAMES UNITS PRICE GROSS TAX 27% NET

3 PER UNIT

4

5 WENDY 67 $15.89 $1,064.63 $287.45 $777.18

6 MICHELLE 89 $13.46 $1,197.94 $323.44 $874.50

7 DAVID 44 $13.00 $572.00 $154.44 $417.56

8 PETER 56 $34.80 $1,948.80 $526.18 $1,422.62

9 MICHAEL 73 $27.68 $2,020.64 $545.57 $1,475.07

10 WAYNE 98 $15.80 $1,548.40 $418.07 $1,130.33

11

12 TOTAL 427 $120.63 $8,352.41 $2,255.15 $6,097.26

Step 4.     Add a thick line to the right of cells A4 to A12.

ADDING RIGHT LINES

a.  Select cells A4 to A12

b.  Click on Format  from the main menu

c.  Click on Cells from the next menu

*   The Format Cells window appears

d.  Click on the Borders tag at the top of the window

e.  Click on the Right border icon in the Border area

f.   Click on the Thick line in the Style area

g.  Click on the OK button

Step 5.     Now that you have made changes to the sheet apply the 'Save' function to resave the sheet

                 with the changes and close it.
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    Check that both files are there by viewing the files listed on the 'File' menu. (Click on

    File, view the bottom listing of files)  Notice 'Unit1.xls' and 'Unit2.xls' are displayed.

Step 7.     Cancel the menu. (Press the Escape key)

At this stage you can exit out of the program and finalise your training or continue to the next

lesson.

LESSON 12.

Microsoft Excel can also be used as a calculator.

Step 1.     Run Microsoft Excel and be positioned on a new sheet.

Step 2.     Calculate in a single cell, this formula :  75 * 98

a.  Press =

b.  Enter 75*98

c.  Press the Enter key

Step 3.     Calculate each formula and enter the answer.  (Remember to press = first)

78+97+54-55 ___________________________

7*8*3 ___________________________

100 / 7 ___________________________

160-5 ___________________________

25000 * 25% ___________________________     (=25000*25%)

15% of 90000 ___________________________

(55+89)-(2*4) ___________________________

(66+75)*33 ___________________________

(6+9+7+8)/4 ___________________________

Step 4.     Close the file and do not save it. (Click on File, click on Close, click on No)
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LESSON 13.

Step 1.     Create the following spreadsheet.  The shaded cells are calculated with a formula.

    (Do not enter the answer manually). The sales tax is calculated by the quantity of

    items multiplied by the price of each item which gives us the total price, then

    multiply the total price by the tax rate. (The formula is described in the next step.)

A B C

1 QTY PRICE SALES TAX

2 15%

3 9 15 20.25

4 5 65 48.75

5 6 72 64.8

6 12 13.8 24.84

Step 2.    Calculate the 'Sales Tax' for column C , working on the  (Qty * Price) * Sales Tax Rate.

In this formula we need the total of the Qty * Price before we multiply it with the Sales Tax rate. So

we must enter appropriate brackets to specify what is to be multiplied first.

a.  Position cursor in C3  (Click in it)

b.  Type =(

c.   Move to cell A3 and press *

d.  Move to cell B3 and type )

e.  Press *

f.   Move to C2

g.  Press the Enter key

Step 3.    Save this sheet and call it 'Loan rate 15%'.

Step 4.    As you still have the 'Loan rate 15%' opened, perform the 'Save As' function and call the

               new sheet 'Loan rate 17%'. (Click on File, click on Save As, enter new name 'Loan Rate

               17%, click on Save button)  Notice the filename displayed on the Name bar.

Step 5.    Change the interest rate from 15% to 17% and notice the formulas recalculate.

   (Simply enter 17% in cell C2) Perform the 'Save' function to sae the new entries to disk.

Step 6.    Delete the entries to cells A3 to B6.  (Select cells A3 to B6, Press Delete key)  Notice all

               the results for the 'Sales Tax' become 0.

=(A3*B3)*C2
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    Undo the last function which was the delete. (Click on the Undo icon)

Step 8.     Select the entire sheet. (Click on the top left corner of the sheet, before the column and

    row labels, the entire sheet should be selected)

Step 9.     Apply the 'Italics' function to all the selected cells.

ITALICS

a.  Click on the Italics icon located on the Formatting bar

 Step 10.     Select the entire row 1.

SELECTING AN ENTIRE ROW

a.  Click on the row label 1 area

*   The entire row becomes selected

Step 11.     Apply the 'Underline' function. (Click on Underline icon)

Step 12.     Perform the 'Save' function to resave the changes to the file on the disk.

Step 13.     Go to 'Sheet 2'. (Click on Sheet2 tag)

Step 14.     Create the following sheet.

Step 15.
    Go to 'Sheet1', (Click on Sheet1 tag).  Perform the 'Save' function to resave

                  the sheet, then close the sheet.

Size = 18, Bold, Underline,

Merge and Center

cells A1 to D1

Widen column

width for A and C

Select cells A3 to A6,

Format, Cells, Border

tag, double style, right

border, Ok

Select cells C3 to C6,

Repeat function

(Edit, Repeat)

Increase or

decrease

percentage

decimal position



LCN: QLD1206  - OUTBACK EDUCATION SERVICE
 

Page 38

MICROSOFT EXCEL 2000

LEARNING STAGE 1 Level 3

 REVISION QUESTIONS

What formula would you enter if you wanted to multiply cell B6 with B7?

____________________________________________________________________________

Which key would you press to delete what is in a cell?

____________________________________________________________________________

What function do the following icons perform?

    _______________________________________________________

   _______________________________________________________

   _______________________________________________________

  _______________________________________________________

How would you add a thick bottom borders to a group of cells?

____________________________________________________________________________

Why would you save a file to another name?

____________________________________________________________________________

What does the 'grey empty label' located top left of the sheet do when it is clicked upon?

____________________________________________________________________________

What does the double-click between the column labels do?

____________________________________________________________________________

How do you select an entire row?

____________________________________________________________________________


